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Information in this document is subject to change without notice and does not represent a comm
Ltd. No part of this manual may be reproduced or transmitted in any form or by any means, electr
and recording, for any purpose without the written permission of Creative Technology Ltd. The
furnished under a license agreement and may be used or copied only in accordance with the term
law to copy the software on any other medium except as specifically allowed in the license agre
the software for backup purposes.

Copyright © 1998 by Creative Technology Ltd. All rights reserved.

Version 1.2 (CLI)
October 1998

Sound Blaster and Blaster are registered trademarks, and the Sound Blaster Live! logo, the Sound Blaster PC
Modeling, Environmental Audio, Creative Multi Speaker Surround, and DynaRAM are trademarks of Crea
other countries. E-Mu and SoundFont are registered trademarks of E-mu Systems, Inc. PCWorks and FourP
SoundWorks, Inc. Microsoft, MS-DOS, and Windows are registered trademarks of Microsoft Corporation. A
registered trademarks of their respective owners.

This product is covered by one or more of the following U.S. patents:
4,506,579; 4,699,038; 4,987,600; 5,013,105; 5,072,645; 5,111,727; 5,144,676; 5,170,369; 5,248
5,342,990; 5,430,244; 5,524,074; 5,698,803; 5,698,807; 5,748,747; 5,763,800.
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Creative End-User Software License Agreement
Ve r s i o n  2 . 0 ,  J u n e  1 9 9 8

PLEASE READ THIS DOCUMENT CAREFULLY BEFORE USING THE SOFTWARE. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE
AGREE TO THE TERMS OF THE AGREEMENT, DO NOT OPEN THE SEALED DISK PACKAGE, INSTALL OR USE THE SOFTWARE. PROMPTLY RET
RELATED DOCUMENTATION AND ACCOMPANYING ITEMS TO THE PLACE OF ACQUISITION FOR A FULL REFUND.
This is a legal agreement between you and Creative Technology Ltd. and its subsidiaries (“Creative”). This Agreement states the terms and conditions upon which Creative 
together with all related documentation and accompanying items including, but not limited to, the executable programs, drivers, libraries and data files associated with such p

LICENSE
1. Grant of License

The Software is licensed, not sold, to you for use only under the terms of this Agreement. You own the disk or other media on which the Software is originally or subseque
(and, to the extent applicable, its licensors), Creative retains all title to and ownership of the Software and reserves all rights not expressly granted to you.

2. For Use on a Single Computer
The Software may be used only on a single computer by a single user at any time. You may transfer the machine-readable portion of the Software from one computer to an
any portion or copy thereof) is erased from the first computer and (b) there is no possibility that the Software will be used on more than one computer at a time.

3. Stand-Alone Basis
You may use the Software only on a stand-alone basis, such that the Software and the functions it provides are accessible only to persons who are physically present at the 
You may not allow the Software or its functions to be accessed remotely, or transmit all or any portion of the Software through any network or communication line.

4. Copyright
The Software is owned by Creative and/or its licensees and is protected by United States copyright laws and international treaty provisions. You may not remove the copyr
the written materials, if any, accompanying the Software.

5. One Archival Copy
You may make one (1) archival copy of the machine-readable portion of the Software for backup purposes only in support of your use of the Software on a single computer,
other proprietary rights notices included on the originals of the Software.

6. No Merger or Integration
You may not merge any portion of the Software into, or integrate any portion of the Software with, any other program, except to the extent expressly permitted by the laws
the Software merged into or integrated with another program, if any, will continue to be subject to the terms and conditions of this Agreement, and you must reproduce on 
proprietary rights notices included in the originals of the Software.
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ltiple systems. Each “node” connected to the “file server” 
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7. Network Version
If you have purchased a “network” version of the Software, this Agreement applies to the installation of the Software on a single “file server”. It may not be copied onto mu
must also have its own license of a “node copy” of the Software, which becomes a license only for that specific “node”.

8. Transfer of License
You may transfer your license of the Software, provided that (a) you transfer all portions of the Software or copies thereof, (b) you do not retain any portion of the Software 
to be bound by the terms and conditions of this Agreement.

9. Limitations on Using, Copying, and Modifying the Software
Except to the extent expressly permitted by this Agreement or by the laws of the jurisdiction where you acquired the Software, you may not use, copy or modify the Softw
Agreement.

10.Decompiling, Disassembling, or Reverse Engineering
You acknowledge that the Software contains trade secrets and other proprietary information of Creative and its licensors. Except to the extent expressly permitted by this A
located, you may not decompile, disassemble or otherwise reverse engineer the Software, or engage in any other activities to obtain underlying information that is not visibl

In particular, you agree not for any purpose to transmit the Software or display the Software's object code on any computer screen or to make any hardcopy memory dump
information related to the interoperability of the Software with other programs, you shall not decompile or disassemble the Software to obtain such information, and you agr
listed below. Upon receiving such a request, Creative shall determine whether you require such information for a legitimate purpose and, if so, Creative will provide such info
conditions.
In any event, you will notify Creative of any information derived from reverse engineering or such other activities, and the results thereof will constitute the confidential in
with the Software.

TERMINATION
The license granted to you is effective until terminated. You may terminate it at any time by returning the Software (including any portions or copies thereof) to Creative. The l
from Creative if you fail to comply with any term or condition of this Agreement. You agree upon such termination to return the Software (including any portions or copies th
enforce any rights provided by law. The provisions of this Agreement that protect the proprietary rights of Creative will continue in force after termination.

LIMITED WARRANTY
Creative warrants, as the sole warranty, that the disks on which the Software is furnished will be free of defects, as set forth in the Warranty Card or printed manual included w
or person is authorized to expand or alter this warranty or any other provisions of this Agreement. Any representation, other than the warranties set forth in this Agreement, w

Creative does not warrant that the functions contained in the Software will meet your requirements or that the operation of the Software will be uninterrupted, error-free or fre
“malicious code” means any program code designed to contaminate other computer programs or computer data, consume computer resources, modify, destroy, record, or transm
of the computer, computer system, or computer network, including viruses, Trojan horses, droppers, worms, logic bombs, and the like. EXCEPT AS STATED ABOVE IN TH
AS-IS WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF
PARTICULAR PURPOSE. CREATIVE IS NOT OBLIGATED TO PROVIDE ANY UPDATES, UPGRADES OR TECHNICAL SUPPORT FOR THE SOFTWAR

Further, Creative shall not be liable for the accuracy of any information provided by Creative or third party technical support personnel, or any damages caused, either directly
result of such technical support.
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tor access area. Check the equipment operating/installation 

 fabricant.   Consulter le mode d’emploi ou le fabricant de 

 provide reasonable protection against harmful interference 
e harmful interference to radio communications. However, 
h can be determined by turning the equipment off and on, 

omply with the Class B limits.

nce to radio or television reception.
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Safety Information

CAUTION: This device is intended to be installed by the user in a CSA/TUV/UL certified/listed IBM AT or compatible personal computers in the manufacturer’s defined opera
manual and/or with the equipment manufacturer to verify/confirm if your equipment is suitable for user-installed application cards.

ATTENTION: Ce carte est destiné à être installé par l’utilisateur, dans un ordinateur compatible certifié CSA/TUV/UL ou listé IBM AT, à l’intérieur de la zone définie par le
l’appareil pour vérifier ou confirmer si l’utilisateur peut y installer lui-même des cartes périphériques.

Notice for the USA
FCC Part 15: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may caus
this notice is not a guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, whic
the user is encouraged to try one or more of the following measures:

q Reorient or relocate the receiving antenna.
q Increase the distance between the equipment and receiver.
q Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
q Consult the dealer or an experienced radio/TV technician.

CAUTION: To comply with the limits for the Class B digital device, pursuant to Part 15 of the FCC Rules, this device must be installed in computer equipment certified to c

All cables used to connect the computer and peripherals must be shielded and grounded. Operation with non-certified computers or non-shielded cables may result in interfere

Modifications

Any changes or modifications not expressly approved by the grantee of this device could void the user’s authority to operate the device.



Notice for Canada

io.
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6     

This apparatus complies with the Class “B” limits for radio interference as specified in the Canadian Department of Communications Radio Interference Regulations.

Cet appareil est conforme aux normes de CLASSE “B” d’interference radio tel que spe’cifie’ par le Ministère Canadien des Communications dans les règlements d’interfe’rence rad

Compliance
This product conforms to the following Council Directive:

q Directive 89/336/EEC, 92/31/EEC (EMC)
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Declaration of Conformity

According to the FCC96 208 and ET95-19

Name: Creative Labs Inc.
Address: 1901 McCarthy Boulevard

Milpitas, CA. 95035
United States
Tel: (408) 428-6600

declares under its sole responsibility that the product

Trade Name: Creative Labs
Model Number: CT4670
has been tested according to the FCC / CISPR22/85  requirement for Class B devices and found compliant with the following standards:

EMI/EMC: ANSI C63.4 1992, FCC Part 15 Subpart B

This device complies with part 15 of the FCC Rules. 
Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesirable operation.

Ce matériel est conforme à la section 15 des régles FCC.
Son Fonctionnement  est  soumis aux deux conditions suivantes:

1. Le matériel ne peut étre source D’interférences et
2. Doit accepter toutes les interférences reques, Y compris celles pouvant provoquer un fonctionnement indésirable.

Compliance Manager
Creative Labs, Inc.

April 28, 1998
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Introduction

Congratulations! You are now the proud owner of Sound Blaster™ Liv
for the Environmental Audio experience.  At the heart of Sound Blast
new processor from E-mu Systems based on E-mu’s highly acclaimed
Darwin hard disk recorder.  The EMU10K1’s more than 2 million tra
processing power are capable of delivering intensive digital mixing a
immersive Environmental Audio experience.  The EMU10K1 is endo

❐ Advanced hardware-accelerated digital effects processing
❐ 32-bit digital processing while maintaining a 192 dB dynamic 
❐ Patented 8-point interpolation that reduces noise/distortion to i
❐ 64-voice hardware wavetable synthesizer
❐ Professional-quality digital mixing and equalization

To support the EMU10K1 audio processor, additional audio technolo
Environmental Audio:

❐ E-mu Environmental ModelingTM accurately positions audio ob
reflections, and ultimately renders the 3D environmental audio

❐ DynaRAMTM technology makes the downloading of sound sam
allocating memory for storing and processing samples—no nee

❐ SoundFont® banks, software libraries of sampled musical instr
downloaded onto host memory as needed.  Less constrained by
“capture” the full expressiveness, tone and color of sounds to d
Environmental Audio.

❐ Creative Multi Speaker SurroundTM  (CMSSTM), multi-speaker 
Sound Blaster Live! Value to support 4 to 8 speakers.  With pr
mixing, multiple sounds can be moved and placed seamlessly 
the Environmental Audio effects of E-mu Environmental Mode
you are presented with a totally immersive audio experience so
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System 
Requirements

For Creative software, your cards require at least:
❐ Pentium® class 133 MHz or equivalent processor
❐ Windows 95, 98 or Windows NT 4.0
❐ 16 MB RAM for Windows 95/98 (32 MB RAM recommended

32 MB RAM for Windows NT 4.0
❐ 72 MB of free hard disk space for Windows 95/98;

55 MB for Windows NT 4.0
❐ Free PCI bus slot for the audio card
❐ Powered speakers or external amplifier (recommended: Cambr

Sound Blaster Live! Value gives you an estimate of the hard disk space
installation screen.  Some applications may require a system configura
Refer to online documentation (README or HLP files) or specificat

Before You Begin The README file on the installation CD-ROM contains information
time of printing. Read the file before you continue.

Getting More 
Information

See the online User’s Guide for MIDI specifications and connector pi
instructions on using the various applications included with Sound Bl

Document 
Conventions

The following typographical conventions are used throughout this do

bold Bold face type identifies words and phrases that are to be en
D:\AUDIO\ENGLISH\WIN95DRV

italic Italic type identifies word and phrases that are to be replac
DEVICE=C:\SBCD\DRV\SBIDE.SYS /D:MSCD001 /P:xx

In the example, you must supply a value for xxx,yy.
Italic in the text may emphasize or identify a word or phra

ALL CAPS A word in all capital letters identifies a key you are to press.
The notepad icon indicates information that is of particular 
before continuing.

The alarm clock designates a caution or warning that can he
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Installing Sound Blaster Live! Value

What You Need Most of the items you need for installation are included.  The followi
components necessary for a complete installation.

Phillips Screwdriver 
(not included)

Audio Card

Creative 
Audio 
Software

Installing your audio card requires 
you to perform the following steps:
• Install the audio card
• Install the Creative audio 

software
• Test the installation.

Refer to the colored insert for 
specific information about the 
audio card.
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Installing the 
Audio Card

To install the audio card:

1. Turn off your computer, and 
disconnect the power cable.

2. Disconnect the monitor and other 
devices that are connected to the 
computer.

3. Remove the computer cover.

4. Locate a PCI slot for the audio 
card.
Remove the slot cover from the 
slot—save the screw to secure the 
audio card.

1

2
Before you remove the computer 
cover, touch a grounded metal 
surface to discharge static 
electricity.

Remove or disable any existing 
audio card and its driver from your 
computer.  Refer to the 
manufacturer’s documentation for 
details.
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5. Align the gold-striped tabs on the 
bottom of the audio card with the 
PCI slot, and firmly press the 
card into place until it fits snugly.

6. Use the screw from the slot cover 
to secure the audio card to the 
frame of the computer—securing 
the card with the screw assures 
proper grounding.

7. Connect the CD audio cable from 
your CD-ROM drive to the audio 
card’s CD audio connector.  Or, 
connect the CD digital (SPDIF) 
cable from your CD-ROM to the 
audio card’s CD SPDIF connector.

You may want to connect the data 
cable to the audio card before 
inserting it.
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8. Connect your speakers, headphones, microphone, joystick, MI
back panel of the audio card.

9. Replace the computer cover.
10. Reconnect the power cable, monitor, and other devices.

Joystick

Stereo, CD player, 
tape deck, etc.

Powered speakers 
(rear) or amplifier

Powered spe
headphones,

MIDI device

If you are connecting a single pair 
of powered speakers (or 
headphones), you must use the 
third jack.  Use the fourth jack if 
you are connecting an additional 
pair of powered speakers.
See the next section, 
“Configuring the Speakers,” for 
detailed information.
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Configuring the 
Speakers

The best speaker configuration for Sound Blaster Live! Value depend
speakers you have connected to the audio card.  For the best audio, C
PCWorks FourPointSurround speaker system is an excellent complem

After installing the Creative Software, open the Speaker utility from t
configuration.  See “Speaker” on page 27 for more information.

Creative’s Cambridge 
SoundWorks PCWorks 
FourPointSurround

After you have installed your FourPointSurround speaker system, ope
4 Speakers option in Speaker Configuration Output.

PCWorks FourPointSurround
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 your PC-DVD drive to Sound 
t Sound Blaster Live! Value to the 

OM to the Sound Blaster Live! 
udio cable.  Connect the PC-DVD 
tor using an MPC-to-MPC (2-pin) 

nd Blaster Live! Value

X_IN connector (MPC)

 connector (JST)

CD_SPDIF connector 
(MPC 2-pin)
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Creative PC-DVD and 
FourPointSurround

To achieve the best possible sound when playing DVD titles, connect
Blaster Live! Value with an MPC-to-MPC (4-pin) audio cable; connec
Encore Dxr2 decoder card with an MPC-to-JST audio cable.

If you have an additional CD-ROM drive installed, connect the CD-R
Value through the CD_IN connector using an MPC-to-MPC (4-pin) a
drive to the Sound Blaster Live! Value through the CD_SPDIF connec
audio cable.

PCWorks FourPointSurround Sou

PC-DVD drive

Encore Dxr2 decoder

CD-IN connector AU

AUX
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With the AUDIO_OUT connector on the Encord Dxr2 decoder card c
connector on Sound Blaster Live! Value, you must enable the AUX in

Two Speakers or 
Headphones

If you have a two-speaker system or want to use headphones, connec
through the Line Out jack—third from the top.

AUX input icon—click the 
speaker icon (below) to enable
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To add two more speakers, connect the additional speakers to the Rea
Value.

Existing Two Speakers Additional Speakers Result

PCWorks PCWorks Environmental

SoundWorks SoundWorks Environmental

MicroWorks MicroWorks Excellent Envi

Creative SBS20, SBS50, or 
similar powered speakers

PCWorks Use the PCWo
existing speake
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Installing the 
Creative Software

The Sound Blaster Live! Value software contains drivers necessary fo
the most of the audio card.  The software installation varies according
system:

❐ Windows 95
❐ Windows 98
❐ Windows NT

Windows 95 When you turn on your computer, Windows 95 automatically detects
you for the software installation disk.  The installation may vary from
previously installed software and hardware.

To install in Windows 95:
1. Turn on your computer for Windows 

95 to automatically detect your new 
hardware.  The New Hardware Found 
dialog appears.

2. Select the Driver from disk provided 
by hardware manufacturer option, 
and click OK.  The Install From Disk 
dialog appears.

3. Insert Sound Blaster Live! Value 
Disk 1 into your CD-ROM drive.  
Enter the path for your CD-ROM 
drive and the software on the disk.  
For example, use the Browse button 
to locate, or type, the following:  

1

2

This manual reflects a software 
installation in an unmodified 
version of the operating system.  
Your installation screens and 
procedure may vary slightly from 
what is shown and described.  The 
variations may be caused by other 
software/hardware installed on 
your computer, or the version of 
the Windows 95 operating system.

If the Sound Blaster software 
installation screen appears, click 
on Exit.  You must install the audio 
card drivers before insalling the 
applications.



Installing Sound Blaster Live! Value     10

EN
G

LI
SH

-ROM drive).  Click OK to install 

allation CD.  For example, use the 
\DIRECTX\DRIVERS\USA.  

ot prompted and want to install the 
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D:\AUDIO\ENGLISH\WIN95DRV (D:\ represents your CD
the Windows 95 drivers.  

4. If prompted, install the gameport/joystick drivers from the inst
Browse button to locate, or type, the following:  D:\DIRECTX
Click OK to install the gameport/joystick drivers.  (If you are n
gameport/joystick drivers, click Start on the Taskbar, select Se
click the Install New Hardware icon.  Follow the on-screen inst
new hardware and, then, select Sound, Video and Game Contro
locate the file you want as described above.)

5. You may be prompted to restart your computer—restart your c
effect.
NOTE:  When your computer attempts to restart Windows 95,
update the system settings.  DO NOT RESET your computer e
be any hard disk activity.

6. If Autorun is enabled and the 
Sound Blaster Live! Value Disk 1 
is in the drive, the Creative 
Software Installation screen 
appears.  The software included 
with your Sound Blaster Live! 
Value is listed on the screen.  
Select Creative Sound Blaster 
Live! Value software and any 
other applications that you want to 
install and click on OK.

Double-click the My Computer 
icon on your desktop, right-click 
your CD-ROM drive icon, and 
click on AutoPlay to start the 
Creative audio software install if 
the CD is in the drive.

You must install the Creative 
Sound Blaster Live! Value 
software in order to use the audio 
card effectively.
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7. Next, the Software License 
Agreement appears.  Read the text 
and click on the Yes button if you 
accept the terms of the agreement.
The README file follows.  Please 
read the file for any last minute 
information not included in this 
manual.  Click Next when 
finished.

8. Next, you are asked to accept the 
default destination directory, or 
enter a new directory.  When the 
directory is correct, click the Next 
button.

9. Next, the Setup Options are 
displayed.  When you select an 
option, the installation continues.

9
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10. The Select Program Folder dialog 
allows you to select the folder to 
which the audio software is to be 
installed, or you may confirm the 
default selection.  Click the Next 
button when the Program Folder is 
correct.

11. The Installation Information 
dialog lists the installation 
selections you have made.
To make changes to your 
selections, click on the Back 
button until you reach the screen 
with the option to be changed.  
Then, click Next until you are 
returned to the Installation 
Information dialog.
If the information is correct, click 
the Next button to continue.
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12. The Creative Sound Blaster Live! 
Value installation screen, similar 
to that shown to the right, appears 
to inform you of the progress of the 
installation.

13. You may be prompted to restart 
your computer—restart your 
computer for the drivers to take 
effect.

14. To install the additional software, 
insert Sound Blaster Live! Value 
Disk 1 and Disk 2, each time 
selecting the software that you 
want to install.
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Windows 98 The following instructions describe the Sound Blaster Live! Value ins

To install in Windows 98:

1. The Windows 98 Add New Hardware Wizard automatically de
Value and attempts to locate the driver media provided by the m
your 
CD-ROM drive and click the Next button.

2. Select the Search For The Best Driver For Your Device (Recom
button.

3. Clear all check boxes and cleck only the Specify a Location ch
button and point to the driver path: D:\AUDIO\ENGLISH\W
CD-ROM drive).  Click the Next button.

4. Click the Next button to install the Windows 98 drivers.
5. Click the Finish button when the installation is complete.
6. Restart your computer for the changes to take effect.

NOTE:  When your computer attempts to restart Windows 98,
update the system settings.  DO NOT RESET your computer e
be any hard disk activity.

7. Follow the software installation instructions for Windows 95.

Windows NT The following instructions describe the Sound Blaster Live! Value ins

To install in Windows NT 4.0

1. Click the Start button on the Taskbar, select Settings, and click
2. On the Control Panel, double-click the Multimedia icon.
3. On the Audio Devices tab page, click the Add option, and choo

option.  Click the OK button.
4. Insert Sound Blaster Live! Value Disk 1 and follow the instructi

installation.

If no sound is heard, see “Sound” 
on page 47 in Chapter 3, 
“Troubleshooting”  for tips.
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Testing the 
Installation

To test the installation:

1. Click in the task bar; select Programs, Creative, and P
Creative PlayCenter appears.
Alternatively, open the PlayCenter by 
selecting its icon on the Creative 
Launcher.

2. On the PlayCenter, click the 
Media icon and select Open 
Media File.

3. Use the Browse dialog to find 
Creative, SBLive, and Media.  
The Media directory should 
contain a number of audio files 
from which you may select to test 
your Sound Blaster Live! Value 
installation.

2
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Using Sound Blaster Live! Value

Sound Blaster Live! Value is supported by a full-range of application
from the audio card:

❐ SB Live! Tour
❐ Creative Launcher
❐ AudioHQ

• SoundFonts
• Device Controls
• Creative Keyboard
• Sound Graph
• Creative Mixer
• Speaker
• Environmental Audio

❐ Soundo’LE
❐ Wave Studio
❐ Creative PlayCenter

Other software included with Sound Blaster Live! Value may be on D
Begin your installation of the additional software as described in “Ins
page 9.

SB Live! Tour SB Live! Tour is a multimedia presentation that guides you through t
with your audio card.  Topics included are Sound Blaster Live! Value
Applications, and Business/Audio Tools.
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Creative 
Launcher

Creative Launcher allows you to organize your desktop and open Cre

The Creative Launcher is installed at the top of your screen.  If it doe
pointer to the top of the screen.  As the pointer reaches the top of the sc
and the Creative Launcher displays as a bar window.  The Launcher c
(the Creative logo at the top left corner), the web site icon, the group t
Environmental Audio icon also appears in the right corner.

Options To set the options for the Launcher:
1. Click the System Menu icon on the Launcher.
2. On the System menu, click Properties.  The Properties dialog a
3. Select or clear the desired options.
4. Click the OK button to apply the changes to the Launcher.

Groups You can place three kinds of items on the Launcher: 
• Subgroups
• Shortcuts
• Plugins.

A subgroup is an item within a group that may contain more items.

The installation creates a number of group tab pages in the Launcher 
Creative applications such as PlayCenter and Control Panel.  It may a
applications for your hardware settings, volume control, Help files or

A plugin is a Creative software module that is integrated into the Lau
Control plugin and the Command Line plugin.

Use the System menu on the Launcher to add, delete, and rearrange g
on the Launcher.
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AudioHQ AudioHQ can be accessed from the Creative Launcher or by opening
Windows taskbar—click Start, select Programs, select Creative, and c
the familiar Windows group to display the icon for each utility:

The AudioHQ interface has the standard look and feel of the Windows
control utilities that allow you to view, audition, or set up the audio p
devices on your computer.
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SoundFonts Creative SoundFont Control allows you to configure MIDI banks wit
as well as set the caching algorithm and space.

Configure a MIDI Bank To configure a MIDI bank:
1. In SoundFont Control, click the Configure Bank 

tab.
2. In the Select Bank list, select the MIDI bank to 

configure.
3. Click the Load button and load the SoundFont file 

you want to the MIDI bank.
The latest file loaded always appears at the top of 
the Bank Stack box.
The top of the stack is indicated by an arrow.

4. To replace a SoundFont file, click the file and then 
click the Replace button.
OR
Double-click the file, and select the replacement.

5. To clear a bank from the stack, select the bank and 
then click the Clear button.
A variation bank can only be cleared by clearing its main bank

6. Repeat Steps 3, 4 or 5 as required.

By stacking a SoundFont file instead of replacing one with the other, 
sounds or use the new selection.

You can “spot” hide particular instruments by loading one or more So
original.

When you clear a SoundFont file, you remove the latest configuration
banks, including the latest configuration of instruments on the Config

Setting the maximum amount of 
cache memory for SoundFont files 
does not mean setting aside or 
reserving the space. The space can 
still be used by your computer or 
other files, if needed.
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Configure an Instrument To configure an instrument
1. In the SoundFont dialog, click the Configure 

Instrument tab.
2. In the Select Bank list, select the bank whose 

instruments you want to configure.  You can select 
any bank.

3. In the Select Instrument list, select the instrument to 
configure.
In the Instrument Stack, you may see an instrument 
entry although you did not load an instrument on 
this page.  The instrument can be found in a bank 
loaded on the Configure Bank tab page.

4. Click the Load button and load a SoundFont or 
single-instrument (for example, .WAV) file.
The last file loaded always appears at the top of the 
Instrument Stack with an arrow pointing to it.

5. To clear an instrument from the stack, select the instrument an
6. For faster processing of SoundFont files, the files are loaded in

maximum amount of cache memory your SoundFont files can 
performance does not suffer from insufficient memory.  You ca
a balanced system performance.
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SoundFont Caching To specify the caching algorithm:
1. On the Options tab page of the SoundFont Control 

dialog, select an algorithm from the SoundFont 
Cache list.

Set the amount of cache for SoundFont files:
1. On the Options tab page of the SoundFont Control 

dialog, move the SoundFont Cache slider to the set 
the amount of cache.

SoundFont Device To change the SoundFont device
1. On the Options tab page of the SoundFont dialog, select the ne

Device list.

Device Controls Device Controls allows you to configure your audio devices for audio
higher on your audio device allows multiple simultaneous Wave play
play several games at the same time, and enjoy the sounds from them

Playback Sessions To set maximum simultaneous wave playback sessions:
1. On the Wave tab page, drag the Maximum 

Simultaneous Wave Playback slider to the right to 
set a higher number of wave playback sessions, or 
to the left to set a lower number of simultaneous 
playback sessions.
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Wave Blaster Emulation To enable Wave Blaster emulation (if available):
1. On the MIDI tab page, select the Wave Blaster 

Emulation check box.
All MIDI output to Wave Blaster is redirected to the 
AWE device.

Wave Blaster emulation is required to hear sound from 
games that do not directly support the AWE device.  That 
is, in the audio devices list of the games, there is no device 
with the label “AWE.”

Wave Blaster Emulation is disabled if your system already has a true 
card installed and correctly configured under Windows 95.

Sound Device To select the sound device to configure:
1. On the Options tab page, click the device you want 

to configure from the Sound Device list.  The 
device is immediately selected.
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Creative Keyboard The Creative Keyboard allows you to play musical notes on various i
would play notes on a piano (or other instrument) while creating or ar
use Vienna SoundFont Studio or another sound editor.

MIDI Input To select a MIDI input device:
1. In the Select MIDI In box on the Options 

dialog, click the correct MIDI port.
2. Click the OK button.

You can now use the external MIDI input device to 
test your sound creation.

You can use external MIDI input devices to audition 
your MIDI banks and instruments.  First, connect a 
MIDI input device to your audio card and, then, select that device in 

Test an Instrument To test an instrument:
1. In Creative Keyboard, click the bank and the instrument you w
2. Click the keys on the keyboard to test the sound.  If you have a

will probably find it easier to use:
• To select multiple notes to play simultaneously, use your rig

key—each key selected is marked by a black dot.
• To release the keys, right-click each one, or click the All No
• To slide across the keyboard, drag the mouse.
• If the playback is sustained too long, click the All Notes Off

To test instruments with MIDI controllers
1. In Creative Keyboard, click the MIDI controller you want to u
2. Specify a value in the Controller Value box or drag the slider t
3. Click the keys on the keyboard to test the sound.  If you have an

be easier to use.

If you do not like the effects on your instrument, click the Reset Cont
controllers to their default values.
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Sound Graph Creative Sound Graph complements the Record Control view of Crea
graphical view of the sounds mixed for recording.

There are three display modes:
❐ VU Display Mode

displays the playback signal levels of the left and right channe
❐ Scope Display Mode

displays the amplitude-to-time relationship between the playba
❐ Spectrum Display Mode

Logarithmic spectrum displays the normal frequency spectrum
logarithmic form, that is, non-linear.  The frequency bands are
kHz, 3 kHz, 4 kHz, 6 kHz, 8 kHz, 10 kHz, 12 kHz, 14 kHz, 16
Fine grain spectrum displays the normal frequency spectrum o
range is 160 Hz to 12 kHz, with a frequency interval of about  
mode is the fine grain version of the spikes spectrum mode.)
Spikes spectrum displays the normal frequency spectrum linea
with a frequency interval of about 86 Hz, and is very detailed.  
the fine grain spectrum mode.)

Double-click the center of Creative Sound Graph to switch to the nex

Click the buttons labeled 1, 2 or 3 on Creative Sound Graph to switch
Mode, Spikes Spectrum Mode, or Fine Grain Spectrum Mode, respec
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Creative Mixer Creative Mixer allows you to control, combine, and manipulate sound
can control the volume of an audio source while running other Windo
and mix different audio sources during playback and recording.

Mixer Menu To access the Mixer menu:
1. Right-click an open area of the Mixer.  The Mixer menu appea

If the Mixer’s title bar is displayed, you can display the menu b
left corner.

Customizing the Mixer You can use your mouse pointer to change the size and shape of the M
the side or corner of the Mixer and, holding down the left mouse butt
shape the Mixer.

To change between record/playback mode, double-click the left mous
open area of the Mixer.

The device panels can be moved, switched, added, and deleted from t
more information.

Mas
ter

MPC-C
DAud

io
Lin

e O
ut

Micr
op

ho
ne

PC Spe
ak

er
Aux

ilia
ry 

In
Te

lep
ho

ne
 

Ans
weri

ng
 D

ev
ice

 

(TA
D)

Wav
e

MID
I

SPBas
s

Tre
ble



Using Sound Blaster Live! Value     25

EN
G

LI
SH

lider left of right to adjust the 
clicking on the slider.

decrease the volume.

olume is increased.  If you mute 

letely mute the sound.

 the Advanced Controls command.
dvanced Controls command.

e record options and click Record.
r in Mixer.
m.

SBLIVEFM.book  Page 25  Tuesday, April 10, 2001  10:45 AM
Playback To select a device in Play (or Volume) Control view:
1. Set the mute box for the device to not muted:  

Muted

Not muted

Balance Sliders Balance sliders are displayed on the bottom of the Mixer.  Move the s
balance of sound from left or right.  Re-center the balance by double-

Volume Control To adjust the volume of a device:
1. Drag its Volume slider up to increase the volume and down to 

If you raise the Play (or Volume) Control Volume slider, the overall v
Play (or Volume) Control, no sound is produced.

In Play Control, setting a device volume slider to zero may not comp

To show volume controls only:
1. If the title bar is displayed, open the Mixer menu, and uncheck

Or, right-click in an open area on the Mixer, and uncheck the A

Recording To select a device in Record(ing) Control and other views:
1. Select the record box to On:

On

Off

To record from a single source:
1. Open the Mixer in Record Control view.
2. Select a source (except “What U Hear”) to record.
3. In a wave recording program (for example, WaveStudio), set th

To adjust the recording volume, adjust the source volume slide
4. To stop recording, click the Stop button in the recording progra
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Effects settings are not applied to the recording output, so your record
if any).  For wet (effects are included) recordings, select the “What U

If you record in monaural and only the left channel can be heard duri
Hear” mode—available only if the “What U Hear” device icon is ava
“Recording from Multiple Sources” for details.

To record from multiple sources:
1. Open Mixer in Record(ing) Control view.

2. If the “What U Hear” device icon is available, select it
Mixer in Play Control view, and select the sources you want to
• To adjust the recording volume, use the “What U Hear” volu

3. If you do not have the icon, select the sources you want to mix
• To adjust the recording volume, use the volume sliders of th

Recording Control view of Mixer.
4. Select your recording sources—make sure they are on.
5. In the wave recording program (for example, WaveStudio), set 

the Record button to start recording.
6. To stop recording, click the Stop button in the recording progra

IF you select the “What U Hear” device icon in the Mixer’s Record C
Control view, the PC Speaker audio source is unavailable and other a

Only one of the following audio sources can be used for recording at 
Microphone, Auxiliary, TAD In.

To record voice commands:
1. Open Mixer in Record Control view.
2. Select a source for the recording.
3. In a wave recording program (for example, WaveStudio), click

recording.
4. To stop recording, click the Stop button.

You can record voice commands 
only if there is a Voice Command 
in the Mixer menu for Voice 
Control.
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The Speaker (Play or Volume Control) controls affect the sound heard
produced by the audio sources.

Speaker The Speaker utility allows you to configure your speakers or headpho
interface to achieve the balance of effects you want.

To configure your speakers:
1. On the Creative Launcher, select AudioHQ and double-

click the Speaker icon.
Or, click the Start button on the Taskbar, select Programs, 
then Creative, followed by Sound Blaster Live! Value  
Click on AudioHQ; double-click the Speaker icon.

2. Select the speaker configuration from the Speaker 
Configuration box.

3. Use Creative PlayCenter (or Windows Media Player) to 
open and play a wave file.  Return to the Speaker dialog and 
drag the wave sound icon from the Panning Source box to 
each speaker in the Preview—you should hear the sound 
from each speaker in turn.
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4. Try placing the sources around you.  As you place them 
further away from you, they sound softer.  You can place 
them anywhere—in front of you, behind you, at either side, 
diagonally, wherever.

To select the audio device:
1. In the dialog, click the Options tab.
2. In the Audio Device box, click the device you want to use.
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Environmental Audio Using multiple speakers, Sound Blaster Live! Value recreates and pro
would hear them with the acoustics, such as reverberation, associated
concert hall, room, cave, tunnel, etc.  The Environmental Audio utilit
elements that make up the sound for an environment.

On the Master tab page, you can define an audio environment by spec
settings—add to or remove effects from an environment, specify the t

To configure the master settings for the effects of an 
audio environment:

1. In the Environmental Audio Control dialog, click 
the Master tab.

2. In the Environment box, select the environment to 
view or modify.
Use a default or custom environment to create a 
new environment.  You cannot save changes to or 
delete a default environment.
Save the new environment with a new name or the 
name of an existing environment in the 
Environment box, and click the Save button.
• To add an effect to the environment:

Click the Add button, select one or more 
effects from the Add Effect dialog and then click the OK bu
the Effects list.

• To change the type of effect:
Click the Type entry in the Effects list and select from the d

• To route the sound to another channel:
Click the Route entry in the Effects list, and select from the 

• To change the amount of effect:
Select the effect and move the Master Amount slider to the 
reflected in the Amount column of the Effects list.
The amount set applies even when the effect type is changed

• To change an effect’s parameters:
Double-click the effect OR select the effect and click the Pa

1

2
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• To remove an effect from the environment:
Select the effect and click the Remove button.

3. Repeat Step 2 until you are satisfied with the configuration.  The
environment or, in the case of a default environment, save the 
typing a new name or the name of an existing custom environm
click the Save button.
If you do not want to save the environment, click the Delete bu

On the Source tab page, you can set the amount of the effects to apply

If the Always Save Settings Automatically check box on the Options 
settings are saved when you quit the Environmental Audio control uti
environment to its original settings unless you clear this check box.

To change the amount of the effects for an audio 
source:

1. In the Environmental Audio Control dialog, click 
the Source tab.

2. In the Select Source box, click the source whose 
effect amount you want to change.

3. To change the amount of an effect to apply to the 
source, select the effect and move the Amount 
slider to the left or right.  The amount is reflected 
in the Amount column of the Effects list.

4. Repeat steps 2 and 3 for each audio source you 
want to configure.

5. When you are satisfied with the configuration, 
save the settings into the current environment or, 
in the case of a default environment, save the settings as a new 
or the name of an existing custom environment in the Environm
If you do not want to save the new environment, click the Dele

1
2

An effect’s parameters and values 
appear in the Parameter list of the 
Edit Effect Parameters dialog.  To 
open the dialog, double-click the 
effect in the Effects list.
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In the MIDI tab page, you can map effects for MIDI playback. To set
controller command when you are authoring a MIDI file in a MIDI se
CakeWalk.

To configure effects for MIDI playback:
1. In the Environmental Audio Control dialog, click 

the MIDI tab.
2. To assign a MIDI controller to an effect, click the 

Controller value in the Effects list and select from 
the drop-down list displayed.
To change the effect amount, go to a MIDI 
sequencer program to specify the Controller value 
when you insert the controller command.

3. When you are satisfied with the configuration, 
save the settings into the current environment or, 
in the case of a default environment, save the 
settings as a new environment by typing a new 
name or the name of an existing custom 
environment in the Environment box, and then 
click the Save button.

To configure an effect:
1. To change the value of a parameter, select the parameter and m

dialog.
You can audition changes without closing the dialog.
To reset to the parameter’s default value, click the Default butt

2. Repeat Step 1 for each parameter you want to change.
3. When the configuration is correct, save the settings into the cu

typing a new name or an existing name in the Type box, and th
4. Click the OK button to close the dialog.

1
2
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If the Always Save Changes Automatically check box 
on the Options tab page is selected, your revised 
settings are saved when you quit the Environmental 
Audio control utility.  You cannot return to a 
previously saved environment unless you clear this 
check box.

Soundo’LE Creative Soundo'LE plays and records wave (.WAV) data, and suppor
(OLE) 2.0.

To open a wave file:
1. On the File menu, click Open.  The Open a Sound File dialog a
2. Select the wave file you want to open.  Information about the fil

size are displayed in the dialog.  You can preview a file by clic
3. Click the OK button.

To play a wave file:
1. Open the wave file.
2. Click the Play button or press the P key.

To stop the playback, click the Stop button or press the S key.

To record a wave file:
1. On the File menu, click New.
2. Click the Record button or press the R key.

To stop the recording, click the Stop button or press the S key.

The .WAV File Length Indicator shows the length of the file in secon
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Embedding a Wave File When you embed a wave file, a copy of the wave file is placed in Sou
application that supports Object Linking and Embedding (OLE).  If yo
the copy of the wave file in the application is not affected.

To embed a wave file from Soundo'LE:
1. Open Soundo'LE.
2. Record a new wave file or open an existing wave file you wan
3. On the Edit menu, click Copy Sound As An Object. The wave
4. Open the document in which you want to embed the wave file
5. On the Edit menu in WordPad, click Paste Special.  The icon re

appears.

Linking Linking a wave file enables you to make references to the wave file w
wave file in Soundo'LE, the changes are reflected in the application c

To link a wave file in an application:
1. Open Soundo'LE.
2. Create a new wave file or open an existing file that you want t
3. Save the wave file if you created a new one.  The wave file mus

an OLE client.
4. On the Edit menu, click Copy Sound.  The wave file is placed 
5. Open the document in which you want to link the wave file.
6. On the Edit menu in the application, click Paste Special.
7. In the Paste Special dialog, click the Paste Link option button 

representing the wave file is placed in the document.

Toolbar The Toolbar gives you quick access to commands and features in Sou
open a new file by clicking the New button on the Toolbar.

There are nine command buttons on the Toolbar:  New, Open, Save, C
Mixer Settings, CD Player, and Select Wave Device.
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Wave Studio WaveStudio allows you to perform the following sound editing functi
❐ Play, edit, and record 8-bit (tape quality) and 16-bit (CD qualit

data or create unique sounds with various special effects and e
reverse, echo, mute, pan, cut, copy, and paste.

❐ Open and edit several wave files at the same time.
❐ Import and export raw (.RAW) data files.

Working with Wave 
Files

Wave format refers to the channel type, sample frequency (sampling 
options must be specified correctly when you perform certain functio
converting wave formats or recording new wave files.

To use the Open command:
1. From the File menu, click Open.  The Open Sound File dialog 
2. In the File Name list, click a file you want to open.  Once a file

• Play button allows you to listen to the playback of the selec
• File format, size, date, and time are shown at the bottom of 
• List Files of Type box allows you to type or select raw data 

3. Click the OK Button.

You can also open multiple files using the drag-and-drop method by h
dragging the files from Windows Explorer to the WaveStudio window

To convert the wave format:
1. From the Options menu, click Convert Format.  The Select Wa
2. Select the format of the wave file.  In the Attributes list, choos

• Sampling rate, frequency may be from 11025 Hz to 44100 H
22050 Hz for tape-quality recording, and 44100 Hz for CD-

• Sampling size, click 8- or 16-bit sample size.  8-bit wave da
to that of a cassette tape.  16-bit wave data gives sound qual

• Mono or Stereo for channel.
3. Click the OK button.

A wave file with better sound quality requires more disk space due to



Using Sound Blaster Live! Value     35

EN
G

LI
SH

le menu.

four ways: 
 file, or the file from the location of 

the selection and back until it is 

 was selected, only the selected 
ions from the location of the cursor 

om playing. These two features are 

 to another to create a new file.  
enerated.

mixing.

g the data.
ars.

om the source file and for mixing 

tereo file.

SBLIVEFM.book  Page 35  Tuesday, April 10, 2001  10:45 AM
To save a wave file:
1. Click the Save button on the Toolbar or click Save from the Fi
2. Enter the name of the file and its path.
3. Click the OK button.

Playback The Audio menu allows you to control playback of your wave file in 
❐ Selecting Auto Playback automatically plays the selected wave

the cursor.  
❐ Loop Playback plays to and from the location of the cursor or 

deselected or until the Stop option is pressed.
❐ Play All Files plays all open wave files.  If a part of a wave file

portion is played.  If your cursor is placed withing the file, port
are played.  

❐ Selecting Stop All Playback immediately stops all wave files fr
available only on audio cards that support these functions.

Mixing When you mix the data of two wave files, the data of one file is added
After mixing, you can play back the new file to hear the new sound g

To mix the data contents of two wave files:
1. Activate the first (source) file and select the data you want for 
2. From the Edit menu, click Copy.
3. Activate the second (target) file and select a location for mixin
4. On the Edit menu, click Paste Mix.  The Paste Mix dialog appe
5. Under From Buffer Use, click the channels for copying data fr

data to the target file under Mix With Wave.
• Select Mono Channel for mono file.
• Select Left Channel, Right Channel, or Both Channels for s

6. Click the OK button.
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Recording To record a new wave file:
1. Click the New button in the toolbar or on the File menu to ope
2. From the Audio menu, click Record.

The status bar below the file displays the message, “Performin
completion percentage.

3. To save the new file, go to the File menu, and click Save As.
4. Enter the new file name and click the OK button.

Check and then change the recording format by clicking the Format b

To record over an existing file:
1. Activate the file to record over.
2. From the Audio menu, click Record Special.

The status bar below the file displays the message “Performing
completion percentage.

WaveStudio also allows you to record over the selected wave file or f
following the same instructions but choosing the relevant commands 

When you open a compressed wave file, WaveStudio decompresses th
must reside on a drive that has sufficient disk space to accommodate 
amount of space required depends on the compression of the wave fo

❐ For CCITT, A-Law, and  µ-Law the ratio is 1:2 (compressed : 
❐ For ADPCM formats, the ratio is 1:4.  For example, if you are 

you must have at least 4MB of free disk space to store the deco

After opening and editing a compressed wave file, WaveStudio autom
save changes.  To save time, save your work first to a temporary unco
editing, save the file in the compression format you want.
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Special Effects Wave Studio allows you to create new sounds by adding one or more
from the Special menu:

❐ Adjust Volume:  Allows you to change the volume of wave file
❐ Echo:  Modifies sound to produce echoing.
❐ Fade-In/Fade-Out:  Creates a fading in (soft to loud) or fading
❐ Insert Silence:  Inserts a pause between sounds.
❐ Invert Waveform:  Turns the wave form over along its horizont

either invert both channels, the left channel, or the right chann
❐ Mute:  Silences a selected portion of a wave file.  For stereo fi

channels, the left channel, or the right channel.
❐ Pan:  Moves the sound from the left channel to the right chann

stereo files.
❐ Phase Shift:  Applies a delay on wave playback in the selected

time or sammples.  This effect applieds only to stereo files.
❐ Rap:  Repeats a portion of the wave file, creating a jerky or stu
❐ Reverse:  Changes the sequence of data so that the sound is pla
❐ Swap Channels:  Exchanges the entire or selected portion of w

right channels.  This effect applies only to stereo files.

Most effects can be applied to:
❐ Entire file by placing the cursor at the beginning of the file or n

data.
❐ Selected portion of the file by using the cursor to select the sec
❐ Section of the file starting at the cursor position to the end.
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Using Volume Meter The Volume Meter is a three-colored bar with scales and markings loc
or windows.  The three-colored region represents the different loudne
in decibels the loudness of your playback or recording.

When recording, adjust the volume so that the sound level falls within
following indicators to help you monitor the volume:

❐ Peak indicator shows increasing volume; the valley indicator s
❐ Five scales representing different volume ranges (-90dB to Inf

To use the indicators to adjust volume:
1. Right-click on the volume meter.  The context-sensitive menu 
2. Click the desired indicator to enable it; a check mark appears b

Clicking on it again disables the indicator; the check mark is n

If you have more than one wave device in your computer (for exampl
card), the volume meter displays these devices.  You can choose whic

Clicking Auto Reset Indicator turns on an automatic timer that resets 
every five seconds or so.  If you want to monitor the peak/valley at a 
Reset Indicator.

On the Preferences dialog from the Options menu, you can change se
editing options, and display colors.

Customizing Settings You can configure the manner in which WaveStudio presents wave da
Windows by making changes on the Preferences dialog, opened from

❐ Display colors
❐ Devices to be used for recording and playback
❐ Default recording format
❐ Settings related to editing and undo operations
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Creative 
PlayCenter

PlayCenter allows you to play most types 
of media, such as multimedia files 
(MIDI, Wave, etc.), audio CDs, Video 
CDs and DVD-Videos.  Just insert or 
select your media and PlayCenter does 
the rest.

PlayCenter also allows you to organize 
and arrange your multimedia files and tracks into albums. 

PlayCenter is usually launched automatically when you insert a disc in
It recognizes the media and starts playback of the disc, if those prefer

Once PlayCenter is launched, place your mouse pointer over a button
or button lights and the corresponding tooltip is displayed.   The Play
different media.  Not all features and functions of the PlayCenter may
grayed out button or menu indicates that the function or option is una

If you are playing a VCD or DVD-Video, the 
Video window appears.  Right-click anywhere in 
the Video window to display the options menu.

To use the DVD function in PlayCenter, you must 
have a Creative PC-DVD drive and the latest 
software components installed in your system.

PlayCenter is usually launched automatically when you insert a disc in
It will recognize the media and start playback of the disc, depending o
does not, follow the steps described below to play your multimedia fi

To launch PlayCenter:
1. On the taskbar, click the Start button, select Programs, select C

PlayCenter.
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To play a multimedia file:
1. Launch PlayCenter.
2. On the PlayCenter interface, click the Media button.
3. On the Media menu, click Open Media File.  The Open dialog
4. Select the multimedia file you wish to play by exploring the di
5. Click the OK button.
6. On the PlayCenter interface, click the Play button.

To play a disc:
1. Launch PlayCenter.
2. Insert a disc into your CD-ROM/PC-DVD drive.
3. On the PlayCenter interface, click the Media button.
4. On the Media menu, select and click the CD-ROM/PC-DVD d
5. On the PlayCenter interface, click the Play button.

To adjust the volume:
1. On the PlayCenter LED display, click and drag the Volume Sli

double-click the desired level on the Volume Slider.

Configuring You can set your preferences as to how PlayCenter is to handle the pl
multimedia files.

To set playback preferences:
1. On the PlayCenter Interface, click the System Menu icon.
2. On the System menu, click Preferences.  The Preferences dialo
3. Select the check boxes for your preferred settings.
4. Enter a value for Intro length (in seconds) to specify the durati
5. Click the OK button.
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To make PlayCenter the default player for discs:
1. On the PlayCenter interface, click the System Menu icon.
2. On the System menu, click Disc Detector.  The Creative Disc D
3. Click the Players tab page.
4. Select the disc type in the list box and click the Select Player bu

appears.
5. In the Target text box, enter the path or click the Browse butto

(that is, C:\PROGRAM FILES\CREATIVE\PLAYCENTER
6. Click the OK button to close the Player Properties dialog.
7. Click the OK button to save the changes and close the Disc De

To make PlayCenter your default player for multimedia files:
1. Launch Windows Explorer.
2. On the menu bar, click View and select Options.  The Options 
3. Click the File Types tab page.
4. Select the multimedia file type in the list and click the Edit but

appears.
5. Click the Edit button
6. Enter the path or click the Browse button to locate the PlayCen

C:\PROGRAM FILES\CREATIVE\PLAYCENTER\CTPL
7. Click the OK button to close the dialogs.
8. Click the Close button to save the changes and close the Optio
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Troubleshooting

This appendix provides tips for solving problems you may encounter during 

Installing Software In Windows 95/98, the installation does not start automatically after the CD

The AutoPlay feature in your Windows 95/98 system may not be enabled.

To start the installation program through the My Computer shortcut menu:
1. Double-click the My Computer icon on your Windows desktop.
2. In the My Computer window, right-click the CD-ROM drive icon.
3. On the shortcut menu, click AutoPlay and follow the instructions on the s

To enable AutoPlay through Auto Insert Notification:
1. Click the Start button, select Settings, and then click Control Panel.
2. In the Control Panel window, double-click the System icon.
3. In the System Properties dialog, click the Device Manager tab and select 
4. Click the Properties button.
5. In the Properties dialog, click the Settings tab and select Auto Insert Noti
6. Click the OK button to exit from the dialog.

Sound There is excessive environmental sound or effects when an audio file is bei

The last selected preset environment is inappropriate for the current audio fil

To select an appropriate environment:
1. Open Environmental Audio control.

OR
Display Creative Launcher at the top of your screen (bring your mouse p
display Launcher).  Then, click the Environments tab.

2. In the Environment list, select “No effects” or an appropriate environmen
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In a 4-speaker configuration, there is no sound from the rear speakers.

Check the following:
❑ The rear speakers are connected to the audio card’s Rear Out jack.
❑ In Creative Mixer’s Record Control view:

• If a single source (for example, CD Audio, Line In, TAD, Auxiliary or
for the source is selected.

• If more than one source is playing, the “What U Hear” device icon is 
the sources you want to mix are selected.

No sound from the headphones.

Check the following:
❑ The headphones are connected to Line Out (front) jack.
❑ In the Speaker dialog (open AudioHQ and click the Speaker icon), set the

No audio output when playing digital files such as .WAV, MIDI files, or AV

Possible causes:
❑ Speaker volume is not set properly.
❑ External amplifier or speakers are connected to the wrong jack.
❑ Hardware conflict.
❑ Output selection in the Configuration tab page on the Speaker dialog is in
❑ Original Sound sliders in either the Master or Source tab pages of the Env

near 0 percent.

Check the following:
❑ The speakers’ volume control is set at mid-range.  Use Creative Mixer to
❑ The powered speakers or external amplifier are connected to the card’s L
❑ No hardware conflict between the card and a peripheral device.
❑ The output selection on the Speaker dialog corresponds to your speaker o
❑ The Original Sound sliders in either or both the Master and Source tab pa

percent.



Troubleshooting     43

EN
G

LI
SH

e and the audio card.

yed and insufficient memory is 

dFont Cache slider to the right to 
nds on the system RAM available.

t a smaller SoundFont bank from the 

sition.  When the processor is fast, the 
t the position is out of range.

ly under the Chipset Feature Settings 
ck.  If the problem persists, try a 

SBLIVEFM.book  Page 43  Tuesday, April 10, 2001  10:45 AM
No audio output when playing CD-Audio.
OR
No audio output when playing DOS games that require a CD-ROM.

To solve this problem:

• Check the connections of the CD audio cable between the CD-ROM driv

SoundFonts There is insufficient memory to load SoundFonts.

This may occur when you a SoundFont-compatible MIDI file is loaded or pla
allocated.

To allocate more SoundFont cache:

• On the Options tab page of the SoundFont Control dialog, move the Soun
increase memory.  The amount of SoundFont cache you can allocate depe

If there is insufficient system RAM available:

• On the Configure Banks tab page of the SoundFont Control dialog, selec
Select Bank box.
The smallest SoundFont bank available is 2 MB (2GMGSMT.SF2). 

Joystick The joystick port is not working.

The audio card’s joystick port conflicts with the system’s joystick port.

To solve this problem:

• Disable the audio card’s joystick port and use the system port instead.

The joystick is not working properly in some programs.

The program may use the system processor timing to calculate the joystick po
program may determine the position of the joystick incorrectly, assuming tha

To solve this problem:

• Increase your system's 8-bit I/O recovery time of the BIOS setting, usual
section.  Or, if available, you may adjust the AT Bus speed to a slower clo
different joystick.

A smaller SoundFont bank usually 
is of lower sound quality.

Do not attempt to make changes to 
the BIOS unless you have 
experience with system software.
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I/O Conflicts Conflicts between your audio card and another device may occur if they are s
resolve I/O conflicts, change the resource settings of your audio card or the co
in Windows 95/98.

If you still are unable to determine which card is causing the conflict, remove a
essential cards (for example, disk controller and graphics cards).  Add each ca
that a conflict has occurred.

To resolve hardware conflicts in Windows 95/98:
1. Click the Start button, point to Settings, and then click Control Panel.
2. In the Control Panel window, double-click the System icon.
3. In the System Properties dialog, click the Device Manager tab.
4. Under the Sound, Video And Game Controllers entry, select the conflicti

exclamation mark (!)—and click the Properties button.
5. In the Properties dialog, click the Resources tab.
6. Select Use Automatic Settings and click the OK button.
7. Restart your computer to allow Windows 95/98 to reassign resources to t

Windows NT 4.0 A Service Control Manager error message appears with one or more other 

This occurs when you remove an audio card from your computer after succes
Value.  Windows is trying to match the drivers to the removed audio card.

To solve this problem:
1. Log on to your computer as Administrator.
2. Click the Start button, select Settings, and then click Control Panel.
3. Double-click the Multimedia icon, and then click the Devices tab.
4. Under the Audio Devices and MIDI Devices And Instruments headings, 

•  Audio for Creative SB Live!
•  MIDI for Creative SB Live!
•  MIDI for Creative S/W Synth

5. Click the OK button to close the dialog.  The unneeded drivers are remov

You can also refer to the 
Troubleshooting section in the 
Help file of Windows 95/98.
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Creative 
PlayCenter

The Creative PlayCenter is not launched when a DVD is inserted into the d

To solve this problem:
1. In Creative Launcher, click Settings, and click the Disc Detector icon,.
2. On the General tab page of the Creative Disc Detector dialog, select Enab
3. Click the Players tab.
4. Select the DVD Disc entry and then click the Select Player button.
5. In the Players Properties dialog, click the Browse button.
6. Browse to C:\PROGRAM FILES\CREATIVE\PLAYCENTER and do

now displays CTPlay.
7. Click the OK button twice to close.
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